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Getting Started with the MapControl

• Loading the MapControl

• Creating a Visual Basic template

• Adding a MapControl

• Displaying property pages and
obtaining help

• Using the property pages

• Updating properties and editing
code

• Using the ArcObjects Developer
Help

• Adding map navigation
functionality

• Handling form resize

• Displaying map layers based on a
scale

• Adding layers through code

• ArcObjects Controls Resources
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4 GETTING STARTED WITH THE MAPCONTROL

Loading the
MapControl
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1. Start Visual Basic and create
a new Standard EXE project
from the New Project dialog
box.

2. Click the Project menu and
click Components.

3. In the Components dialog
box, click ESRI MapControl
8.3 and click OK.

The MapControl appears in
the Visual Basic toolbox.

4. Click the Project menu again
and click References.

5. In the References dialog box,
click ESRI Object Library and
ESRI Controls Support
Library 8.3, then click OK.

If ESRI Controls Support
Library is not available in the
list, click the Browse button,
navigate to the Bin folder of
your ArcGIS installation, and
select the
ControlsSupport.dll.

MapControl icon
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Creating a Visual
Basic template
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Creating a template for
the MapControl

1. Follow steps 1–5 in the
‘Loading the MapControl’
section to load the
MapControl into a new Visual
Basic project.

2. Click the File menu and click
Save Project As.

3. Navigate to the Visual Basic
template folder C:\Program
Files\Microsoft Visual
Studio\VB98\Template\Projects
and type the filename ArcGIS
Controls.vbp.

4. Click Save.

Using the MapControl
template

1. Open Visual Basic and open
the template you created
from the New Project dialog
box.

Visual Basic opens with the
MapControl already loaded
into the toolbox.
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6 GETTING STARTED WITH THE MAPCONTROL

Adding a
MapControl
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1. Click the MapControl icon in
the Visual Basic toolbox.

2. Click and drag from one
corner to the opposite corner
on a Visual Basic form to
place the MapControl.

Alternatively, double-click the
MapControl icon in the Visual
Basic toolbox and the
MapControl will automatically
be placed on the form.

MapControl
icon
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Displaying
property pages
and obtaining
help
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Displaying the property
pages

1. Right-click the MapControl
and click Properties to open
the MapControl property
pages.

Obtaining property page
help using the What’s
This button

1. Right-click over a control or
label on the Property Pages
dialog box.

2. Click the What’s This button.

Help for the control displays.

3. Click anywhere on the
Property Pages dialog box to
close the help.

Obtaining property page
help using the Help
button

4. Click the Help button on the
Property Pages dialog box.

The ArcObjects Developer
Help will open and display
help about the selected
property page.
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8 GETTING STARTED WITH THE MAPCONTROL

Using the
property pages to
add data
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Adding data layers

1. Right-click the MapControl
and click Properties to open
the MapControl property
pages.

2. Click the Layers tab.

3. Click the Add Layers button.

4. In the Add Layers dialog box,
navigate to a folder
containing sample data.

5. Click on and highlight the
data you want to add. To
highlight multiple data layers,
hold down the Shift key. Then,
click the Add Layers button.

6. Click OK to apply the
changes you have made and
close the property pages.

7. Click the Run menu and click
Start.

Adding data from map
documents

1. Right-click the MapControl
and click Properties to open
the MapControl property
pages.

2. Click the Layers tab. �

Add
Layers
button
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3. Click the Browse Map
Document button.

4. In the Map Documents dialog
box, navigate to a folder
containing a map document
of your choice.

5. Click on and highlight a map
document, then click the
Open button.

6. Select a map in the Maps in
the Map Document
dropdown list from which to
add data.

7. Click the Load Selected Map
button to add all data layers
within the selected map.

8. Select a specific layer within
the Layers in Selected Map
box. Click the Load Selected
Layer button to add the
selected layer. To select
multiple data layers, hold
down the Shift key.

9. Optionally, repeat step 6 to
select another map from
which to add data.

10. Click OK to apply the
changes you have made and
close the property pages.

11. Click the Run menu and click
Start.

Browse Map
Document button

Load Selected
Map button

Load Selected Layer button
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10 GETTING STARTED WITH THE MAPCONTROL

Using the
property pages to
manage data
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1. Right-click the MapControl
and click Properties to open
the MapControl property
pages.

2. Click the Layers tab.

3. Assuming that data has
already been added, select
and highlight a layer in the
MapControl Layers list box. If
data has not been added,
see the task ‘Adding data
from map documents’.

4. Click the Move Layer Up and
Move Layer Down buttons to
move the selected layer up or
down the layer list and the
drawing order for the
MapControl.

5. Click the Properties button to
display the Layer Properties
dialog box for the selected
layer. Use the dialog box to
change any layer properties,
such as symbology.

6. Click the Delete Layer button
to remove the selected layer
from the MapControl Layers
list.

Properties button

Move
layer
up
and
Move
layer
down
buttons

GettingStartedMapControl1.pmd 10/23/02, 1:58 PM10



11

Setting control
appearance with the
property pages

1. Right-click the MapControl
and click Properties to open
the MapControl property
pages.

2. Click the General tab.

3. Check the Preview in Design
Mode check box.

4. Click Apply.

If necessary, move the
property pages so that the
MapControl can be seen on
the form. The MapControl will
appear on the form as it
would at run time.

5. Optionally, select a different
Border Style or Appearance
from the dropdown lists.

6. Optionally, select a different
Mouse Pointer from the
Mouse Pointer dropdown list.

The selected Mouse Pointer
will display as the mouse
passes over the control.

7. Click Apply to view the
changes while in design
mode.

8. Click OK to apply the
changes you have made and
close the property pages.

9. Click the Run menu and click
Start.
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12 GETTING STARTED WITH THE MAPCONTROL

Using the
property pages to
set map
properties
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1. Add data to the control (see
the section ‘Using the
MapControl property pages
to add data’).

2. Click the Run menu and click
Start.

View the data in the
MapControl.

3. Click the Run menu and click
End.

4. Right-click the MapControl
and click Properties to open
the MapControl property
pages.

5. Click the Map tab.

6. In the Rotation (degrees) text
box, type in a rotation
between 0 and 360.

7. Click OK to apply the
changes you have made and
close the property pages.

8. Click the Run menu and click
Start.
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Updating
properties and
editing code
���
'��"�	
(����
 ��������
������
 ���
 ���
���������	
��������
 ��,��
 �		��
 ����
������
 ��
 ����
���������	
����������
�����"�
 ���
 ����
 ��
�����
 �����

���
 �"����
 ��
 ����������
�*��	��	�
*��
���
'��"�	
(����
��������
������
���
 	������
��
�����
 ����
 ��*�
 ����	�
 ���
 ��
���"��
 �����)
 �"��
 ��
 ����,���
���
 �����,��
 �����
 ����������
���
 ����
����
 ���
 ����������	9
���������
$���
�����	�)
���5����
 ��
������������	�%
���
 ���
 ���
 ��
 ��������
'��"�	
(����
 ������	
 ����������
 $���
�����	�)
:���)
3��,��)
���
&����%�

���
���������	
 ��������
��,��
 �		��
 ������
 ��
 �
 �"����
��
����������
 ��6��
��	�
 ����
���
 ����������	9
 ���������)
 �"�
���	"��
 ����
 ����������
����
����
����	��
���
��
���"��
�����)
 �"��
 ��
 #�����
 ���
������	
����������

Updating properties

1. Click the MapControl on the
form to make it active.

2. Press F4 or click the View
menu and click Properties
Window.

3. Click the (...) button by the
Custom property to open the
MapControl’s property
pages.

Editing Code

1. Click the MapControl on the
form to make it active.

2. Click F7, double-click the
MapControl, or click the View
menu and click Code.

The OnMouseDown event is
the MapControl’s default
event.

3. Click the dropdown arrow on
the right-hand side and click
an event to edit.

Visual Basic creates code
stubs for each event so that
you can immediately begin
adding code.

(...) button
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14 GETTING STARTED WITH THE MAPCONTROL

Using the
ArcObjects
Developer Help
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Opening ArcObjects
Developer Help

1. Make the MapControl active
by clicking it.

2. Press F1.

Getting help through the
Object Browser

1. Press F2 or click the View
menu and choose Object
Browser.

2. Select esriMapControl from
the Project/Library dropdown
list.

3. Click MapControl in the
Classes list box and click an
event, method, or property
from the Members list.

4. Click the Help button to open
help about the event,
method, or property you are
interested in.

Getting help from the edit
window

1. Make the MapControl active
by clicking it.

2. Press F7, double-click the
MapControl, or click the View
menu and click Code.

3. Hover the pointer over a
word that is an ArcObjects
object, property, method, or
event.

4. Press F1.
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Adding map
navigation
functionality
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Adding ZoomIn functionality

1. Double-click the MapControl to display the Visual Basic code window.

2. Add the following code to the OnMouseDown procedure:

��������	
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3. Click the Run menu and click Start.

4. Click the map with the left mouse button and drag out a rectangle.

5. Release the mouse button.

The map redraws.

6. Click the Run menu and click Stop to return to design mode.
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Adding Pan functionality

1. Double-click the MapControl to display the Visual Basic code window.

2. Amend the code in the OnMouseDown procedure as follows:
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3. Click the Run menu and click Start.

4. Click and drag the map to a new location.

5. Release the mouse button.

The map redraws.

6. Click the Run menu and click Stop to return to design mode.
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Adding Zoom to Full Extent functionality

1. Double-click the CommandButton button in the toolbox to add a command button to the form.

2. Click the command button and drag it to the lower-right corner of the form.

3. Press F4 to display the properties window.

4. Click in the caption box and type Full Extent to change the button’s caption.

5. Double-click the Full Extent button to display the code window.

6. Add the following code to the Click procedure:

��������	
����##��.�����+,�&

����
��������'("�����)���
��������'0
��("����

(�.�	
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7. Click the MapControl and press F4 to display the properties window. Set the ShowScrollbars
property to False.

8. Click the Run menu and click Start.

9. Use the mouse buttons to zoom in on and pan around the data.

10. Click the Full Extent button to redraw the map at the full extent.

11. Click the Run menu and click Stop to return to design mode.
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Creating a Find
tool
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1. Add the states.shp and ushigh.shp sample datasets to the MapControl using the property
pages. For more information about how to do this, see the ‘Using the property pages to add
data’ section.

2. Double-click the Label button in the toolbox to add a label to the form.

3. Click the label and drag it to the lower-left corner of the form.

4. Press F4 to display the properties window, then set the caption of the label to State.

5. Double-click the TextBox button in the toolbox to add a text box to the form.

6. Click and drag the text box to position it next to the label.

7. Press F4 to display the properties window, then clear the text property of the text box.

8. Double-click the TextBox to display the code window.

9. Select the Text1 KeyPress event from the right-hand dropdown list.

10. Add the following code to the Text1 KeyPress procedure:
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11. Click the Run menu and click Start.

12. Type the name of a state into the TextBox, for example, New Jersey.

13. Press Enter.

14. Click the Run menu and click Stop to return to design mode.
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Handling form
resize
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Responding to the Form Resize event

1. Double-click the form to display the code window.

2. Select the Resize event from the right-hand dropdown list.

3. Add the following code to the Form Resize procedure:
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4. Double-click the form to show the code window.

5. Add the following code to the Form Load procedure:
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�
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1. Click the MapControl and press F4 to display the properties window. Set the ShowScrollbars
property to False.

2. Click the Run menu and click Start.

3. Use the mouse buttons to zoom in on and pan around the data.

4. Click the Full Extent button to redraw the map at the full extent.

5. Click the Run menu and click Stop to return to design mode.
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Displaying map
layers based on
scale
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Setting scale breaks

1. Add the counties.shp to the MapControl using the property pages. For more information about
how to do this, see the ‘Using the property pages to add data’ section.

2. Click the counties layer in the property page to select it, then use the arrow buttons to move it
to the middle of the layer list (beneath the ushigh layer).

3. Click the Properties button to display the counties layer’s properties. Click the Symbology tab,
click Categories, then click Unique Values.

4. Click STATE_NAME in the Value Field and click the Add All Values button, then click OK in the
Layer Properties dialog box and click OK in the property pages.

5. Add the following code to the Form Load procedure (after Form Resize):
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6. Run the application. Zoom in until the counties layer becomes visible. Notice that when you
click the Full Extent button, the counties layer is no longer visible.
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Adding layers
through code
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Loading data programmatically

1. Display the MapControl property pages and click the Layers tab.

2. Click the ushigh layer, then click the Delete button to remove it.

3. Repeat step 2 for the counties and states layers, then click OK to dismiss the property pages.

4. Double-click the form to show the code window.

5. Select the General section from the left-hand dropdown list and add the following procedure
to the General section:

��������	
�����.��
�����&

��2� ������ ���
�� ������!��+����
����+</	�������������

����#����� ����	�����

������ �)�6�GH��+���H��+�"�IJH��+��K�+���������
���1��H	�#
���H����HB��7

����2�������������	 �
�!���;��,�
�+�0�+�������K�+�

����#�
;��,�
�+�0�+��������/;��,�
�+�0�+����

��	���
;��,�
�+�0�+�����)�5���	 �
�!���;��,�
�+�0�+����

��2���������!���
������,�
�+�

����#�
0���
��;��,�
�+�����/0���
��;��,�
�+�

��	���
0���
��;��,�
�+��)�
;��,�
�+�0�+����'�
��0��#0�������� ��3&

����2�������������!���
�����������.�������������� �
�!���

����#�
0���
�����������/0���
�������

��	���
0���
��������)�5���0���
�������

��	���
0���
�������'0���
��������)��

��
0���
��;��,�
�+�'�
��0���
��������6������7&

��
0���
�������'5�#��)�
0���
�������'0���
�������'�����5�#�

����2�..�� ��!���
������������� ��#�


����
��������'�..������
0���
�������

��2�..�� ��� �
�!��������� ��#�


����
��������'�..	 �
�0�������� ��6+�
�����7

����
��������'�..	 �
�0�������� ��6
� �� 7

(�.�	
���

GettingStartedMapControl1.pmd 10/23/02, 1:59 PM23



24 GETTING STARTED WITH THE MAPCONTROL

6. Insert the following line of code into the Form Load event immediately after the call to
Form_Resize and before the section of code that sets the minimum and maximum display
scales for the layers:

���.��
����

7. Run the application.

The map should appear as before, but default colors and renderers are used that may be
different from the colors previously selected in the Layer Properties dialog box.
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ArcObjects
Controls
Resources
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1. Open the ArcObjects
Developer Help to obtain
more information about the
controls and access
samples, component help,
and object model diagrams.

2. Go to ArcObjects Online (can
access it via
http://support.esri.com) to
view an online version of the
ArcObjects Developer Help.
The online version is
frequently updated with new
samples and component
help.

3. Go to the ArcGIS Discussion
Forum:

http://support.esri.com/
forums/
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